
Contents
Abstract i

Exceutive Summary ii

Acknowledgements iii

List of Figures v

List of Tables vi

I Introduction 1

1 The Universiry of Waterloo 1
1.1 Department of Chemical Engineering . . . . . . . . . . . . . . . . . . . . . . 3

2 Safety Practice for Employee 4
2.1 Employee WHMIS 2015 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.2 Employee Safety Orientation . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.3 Workplace Violence Awareness . . . . . . . . . . . . . . . . . . . . . . . . . . 7

3 Simulation fields 9
3.1 Compulational fluid dynamics (CFD) analysis . . . . . . . . . . . . . . . . . 9

4 Project background 18

II Training Activities 19

5 Background 19
5.1 Project background . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
5.2 Fundamental Mechanisms . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

6 Literature Review 28
6.1 Modeling of diffusion controlled drug delivery [Review] [3] . . . . . . . . . . 28

7 ANSYS Engineering Software for Simulation 30

8 Setting up the experiments 30
8.1 Set up experiments on 2D analysis . . . . . . . . . . . . . . . . . . . . . . . 32
8.2 Method of calculation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
8.3 Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

9 Results 37
9.1 Intial trials simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
9.2 Controlling velocity inlets . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

1



9.3 Controlling density of fluids . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
9.4 Vancomycin properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
9.5 Reaction on drug and blood . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
9.6 Add pseudo-layer of polymer . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
9.7 3D analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

10 Verification 56

III Knowledge and gained from training 58

11 Research skills 58

12 Simulations 58

IV Comments and recommendations 59

References 60

Appendix 61

A Appendices 61
A.1 2D diffusion modeling on drug eluting out of sphere . . . . . . . . . . . . . . 61

2



Chemical Engineering Summer Internship Report at
the University of Waterloo

Computational Fluid Dynamic (CFD) analysis
of an antibiotic drug eluting on orthopedic implants simulation

Romrawin Chumpu

Submitted in partial fulfilment of the requirements of

the course CHS301 Chemical Engineering Traning

the bachelor’s degree of Chemical Engineering

August 14, 2018

School of Bio-Chemical Engineering and Technology

Sirindhorn International Institute of Technology

Thammasat University

Thailand



Abstract

One of the branches of medical treatments for arthritis symptoms is Osteoarthritis. Well-
Known orthopedic surgery to recover these symptoms is hip arthroplasty or hip replacement.
The development is getting the emphasize on when we insert the artificial joint (implants)
into our body, bacteria in the surrounding can come along with even the instruments have
been sterilized. To protect our body, many researched try to add or coat antibiotics drug
in the implant parts. From previous works studied to extend the time for drug-eluting on
orthopedic implant from 2 days to 30 days. By controlled diffusion release on the system. On
the orthopedic implant, the appropriate time and concentration of an antibiotic drug would
suggest during the surgery. The fluid flow of antibiotic prescription and its release profile
are predicted correctly from the simulation to decrease the risk of a real test. Therefore,
the work aims to simulate the antibiotic drug(vancomycin) release profile from the given
mathematical model and to observe the flow of antibiotic drug from various geometry. The
procedure and simulation have done in ANSYS software. The result shows that the faster
velocity inlet, the less density of medicine, and no reaction of the blood-drug condition given
the more correction by R2 0.944(95%CI) to the KMUTT model. For the theoretical model
the slower velocity inlet, the high density of the drug from 500to1000kg/m3, and no reaction
conditions resulted in R2 0.9999 (95%CI) for the theoretical model.
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Exceutive Summary

Background: From previous works, the center of interest of orthopedic surgery includes the
development of drug-eluting from an orthopedic implant. One of the branch in medical
treatments for arthritis symptoms is Osteoarthritis or the pain on the hip joint. By the
increasing of the patients, a well-known orthopedic surgery to recover these symptoms is
hip arthroplasty or hip replacement. The development is getting the emphasize on when we
insert the artificial joint (implants) into our body, bacteria from the surrounding can come
along with even the instruments have been sterilized. To protect our body, many types of
research try to add or coat antibiotics drug to the implant parts. The simulation project
aims to stimulate the controlled-release of antibiotics medications from the various geometry
of implant parts.

Method: We used computational fluid dynamic (CFD) to analyze to the model of diffusion
release on orthopedic implant model. The ANSYS software used in the calculation. The
experiment divided into two part; 2D cylinder analysis and 3D sphere analysis. To observe
the factors and conditions, the test varies on velocity inlet, density, reaction, and pseudo-layer
conditions.

Results: The results give the released profile of each conditions in the form of

Mt

M∞
= 1− e−ax−b

Where Mt
M∞ refers to mass release at the time point over the total mass release, a and b refers

as a constant. The model velocity-2 and density-1 resulted in the best performance for the
KMUTT model. Also, velocity-1 and density between 2-3 resulted in the nearest correlation
coefficient to the theoretical model

Conclusion: Simulation on orthopedic implant vancomycin diffusion can adequately perform
in any condition. However, the accurate simulation also needs the status of the drug that
nontoxic to the organism. For the simple simulation, we also vary on any conditions which
can summarize that the slowest velocity inlet and the highest density with no reaction on
blood-drug condition resulted in the longest time of release profile.
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Part I

Introduction

1 The Universiry of Waterloo

The University of Waterloo was estabished in 1957 by the innovators and the entrepreneur of
a group of business. The University of Waterloo is a public research university with a main
campus in Waterloo, Ontario, Canada. The university offers academic programs administered
by six faculties and eleven faculty-based schools. The University of Waterloo is most famous
for its cooperative education (co-op) programs, which allow the students to integrate their
education with applicable work experiences. The University claims to operate the largest
post-secondary co-operative education program in the world, with over 17,000 undergraduate
students in over 140 co-operative education programs.

Figure 1: Sign of the University of Waterloo

Faculties and schools, which operate a combined total of 11 schools and over 50 academic
departments

Innovative solutions, innovative education at Waterloo

University of Waterloo is the place was built to teach people to think in new and innovative
ways. That meant reaching out across disciplines and faculties, sharing resources, and
sparking new directions in research. It meant working hand-in-hand with industry, letting
people own their intellectual property and the success that came from commercialization.
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Faculties and Schools of the University of Waterloo
Faculty School
Applied Health Sciences School of Public Health and Health Systems
Arts School of Accounting and Finance

Balsillie School of International Affairs
Renison University College

Engineering School of Architecture
Environment School of Environment, Enterprise and Development

School of Environment, Resources and Sustainability
School of Planning

Mathematics David R. Cheriton School of Computer Science
Science School of Optometry and Vision Science

School of Pharmacy

Table 1: Listings of faculties and schools in the University of Waterloo

Constructed on a foundation of science, engineering and math, Waterloo has also become a
leader in environmental education, architecture, the arts, psychology and human health.

Figure 2: Trainee at the University of Waterloo sign
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1.1 Department of Chemical Engineering

A chemical engineering building was the first to rise in 1958, Also, as the first facauty on the
university. Chemical engineers are the person at the forefront of technology and their role in
modern society is becoming increasingly important. At Department of Chemical Engineering,
thdy design, implement and supervise industrial processes where matter undergoes change.
This could be led in the pharmaceutical, pulp and paper, food or plastics industries for
example - anywhere a transformation of matter occurs. Chemical engineering here also play
a major role in the emerging field of nanotechnology, with applications in the development
of new materials and devices. They develop new processes to prevent pollutants from
being released into our environment or to remove them after they are already there. The
research decrease our energy use by increasing the efficiency in fossil fuel refining plants, or
by experimenting with new forms of energy generation and storage. Increasingly chemical
engineers are becoming involved in the control, manipulation and production of biological
systems as well, which have many important applications in the area of health care and food
production.

1.1.1 Chemical Engineering Programs

A large faculty complement, with a wide variety of expertise ranging from biotechnology,
nanotechnology, polymers and materials science, to environmental and energy topics like
global climate change and fuel cells. Being Chemical Engineering student at the University of
Waterloo have access to this expertise for career suggestions, research experience, or guidance
during projects.

Options available to chemical engineering students:

• Biomechanics
• Environmental Engineering
• International Studies in Engineering
• Life Sciences
• Management Sciences
• Mathematics
• Physical Sciences
• Statistics
• Water Resources

1.1.2 Research and Development

The spirit of Waterloo’s chemical engineering research is both collaborative and interdisci-
plinary. Our faculty members hold cross appointments in Biology, Chemistry, Civil Engineer-
ing, Mechanical Engineering, Earth Sciences, Environmental Studies and Physics.

With more than 200 graduate students and 39 faculty members, our research covers all
the major areas of chemical engineering - from core areas, such as; polymers, reaction
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engineering and process systems engineering, to emerging areas, such as; fuel cell research,
tissue engineering and nanotechnology.

Our research strengths include:

• Biochemical engineering, tissue engineering and industrial biotechnology
• Chemical kinetics, catalysis and reactor design, energy conversion and fuel cells
• Colloid and surface science, interfacial engineering
• Electrochemical process research and modeling
• Environmental and pollution control
• Flow in porous media and enhanced oil recovery
• Mathematical analysis, statistics and control (process systems)
• Nanotechnology
• Polymer reaction engineering, polymer processing and rheology
• Separation Processes
• Transport phenomena

Over the years we have developed an extensive network of industrial connections. The
Institute for Polymer Research, for example, has the highest density of polymer reaction
engineering researchers internationally in a single group - a distinction that helped earn the
institute a global reputation for research initiatives in a wide variety of companies.

The Cell Factory Bioprocessing Research Network is a multi-university research network
funded by Natural Sciences and Engineering Research Council of Canada (NSERC) and
industrial partners. CellNet’s research aims to develop biological cells as miniature factories
for new and improved bio-manufacturing strategies.

Our recently updated laboratories, including a shared analytical instrumentation laboratory,
provide the latest equipment. There are dedicated facilities and software for computational
work as well, including access to Canada’s largest supercomputing cluster.

In our labs, student and visitor safety is considered to be of prime importance. All researchers
are required to complete online safety training from the University of Waterloo Safety Office.
In addition, all researchers must read the Chemical Engineering Safety Manual and write a
report addressing the safety aspects of their research project. The report is submitted to the
Departmental Safety Manager, Ralph Dickhout, prior to working in any of our laboratories.

2 Safety Practice for Employee

Being a short term researcher at the Uniniversity of Waterloo have been a lot of process
including safety introduction. Eech employee must take an onlin learning about safetry in
workplace and laboratory.

Three courses that I have taked and these all provides to the employee:

• Employee WHMIS 2015

4



• Employee Safety Orientation (SO1001)
• Workplace Violence Awareness

2.1 Employee WHMIS 2015

The Workplace Hazardous Materials Information System (WHMIS) has aligned with the
Globally Harmonized System of Classification and Labelling of Chemicals (GHS). GHS is
a worldwide system. Its goal is to have a common set of rules for classifying hazardous
products, common rules for labels, and a standard format for safety data sheets (SDSs).

This online training module familiarizes employees with WHMIS 2015 and covers:

• Learn the hazards associated with WHMIS-regulated products.
• Understand the WHMIS 2015 hazard classes and symbols.
• Learn the purpose, content and function of Safety Data Sheets (SDS).
• Learn the legal rights and duties under WHMIS.

2.2 Employee Safety Orientation

This safety training module covers health, safety and environment information and services
that apply to University of Waterloo workers, which not only includes paid workers, but also
post-doctoral fellows, graduate students, unpaid learners, teaching assistants and research
assistants. In this safety training module you will learn important and valuable information
about your role and your rights and responsibilities in health and safety procedures at
Waterloo. This training module outlines general health and safety information, while your
faculty or department will have additional health, safety and environment requirements that
are specific to your work area.

2.2.1 Internal Responsibility System (IRS)

Within an organization, such as the University of Waterloo, everyone is responsible for
health and safety. This means that all faculty, staff, students, visitors and contractors share
responsibility for health, safety and environmental care. The particular practices that make
a workplace safe are specific to the work that each of us does.

This system of practices and procedures is called the Internal Responsibility System, which
is in place to keep everyone at Waterloo healthy and safe. It is critical that we all do our
part to work collaboratively towards a healthy and safe work environment. The figure here
depicts the IRS and the flow of responsibility and accountability.

Authority and responsibility for health and safety are delegated downward, from senior levels
ALL the way down to EACH individual worker.

5



Accountability for health and safety flows upward, where individual workers are held to
lesser account legally, and rely on their superiors to correct hazards that they cannot correct
themselves.

2.2.2 Invisible Hazards

Not all hazards can be seen. You also need to think about less visible hazards related to
your work - things like chemicals, fumes, toxic dust, germs and viruses in labs and healthcare
workplaces.

Some of these hazards can make you very sick. Sometimes they make you sick right away;
other times you don’t know that you are sick until months or even years later. That’s why
it’s important to know about these hazards now.

The University and your supervisors must implement controls to reduce or eliminate hazards
in the workplace. The simplest method of hazard control is to eliminate or remove the hazard.
If this is not a feasible option other methods such as engineering or administrative controls
need to be implemented. These types of controls include physical guarding and the use of
Standard Operating Procedures and they need to be considered before relying solely upon
Personal Protective Equipment.

The Employer’s Duty Make sure that supervisors know enough and have enough experience
and training to know where safety hazards may be and keep workers safe and healthy while
they work.

The Supervisor’s Duty Inform workers of health and safety hazards.

The Worker’s Duty Report hazards they know of to the supervisor or employer as soon as
possible so they can fix it.

Employers, supervisors and workers work together to make the workplace safer.

This training module will help you better understand the health and safety systems in place
at Waterloo and your personal role and responsibility.

Dealing with Injuries and Health and Safety Incidents Do you know what to do if there is an
injury or incident while you are at work?

If you are not sure, you are not alone. As a worker at Waterloo knowing what the proper
procedure is in the event of an injury or incident at work is your responsibility. It is important
that you are clear on the standard procedure.

In this final section of the Health and Safety Orientation Module you will learn what the
proper incident procedure is and details on how and where to get help and how to properly
report incidents.

If you are injured at work seek appropriate medical attention immediately.

Do not hesitate to call 911 if you feel the situation requires emergency medical assistance.

6



The following steps must be followed in the event of an injury or incident at work:

1. Obtain first aid or appropriate medical aid if necessary.
2. As soon as possible report the injury to your supervisor.
3. With your supervisor, complete the Incident and Investigation Report and send the

report to the Safety Office. In addition to reporting injuries, everyone is expected to
report to their supervisor near misses that have a potential for serious loss or high
severity of injury. Incidents of this type could potentially have caused:

• Loss of life
• Fire or explosion
• Critical injuries (e.g., broken arms/legs, amputation, severe bleeding, blindness, severe

burns)
• Equipment or property damage

4. If applicable, file a Workplace Safety and Insurance Board (WSIB) claim and participate
in return to work.

2.3 Workplace Violence Awareness

Workplace Violence and Harassment Prevention - for employee Awareness Training

The Occupational Health & Safety Act includes legislation that protects workers from
workplace violence and harassment.

Workplace Violence can effect people in any business or occupation. Legislation require
employers to protect employees from hazards in the workplace including violence. In University
is commited to be violence free. Awareness will help to reduce the risk of violence by knowing
what todo in the violent situation

Workplace violence is

• the excercise and attempt of physical force by a person against a worker in a workplace,
that causes physical injury to the other workers.

• a behavior that a worker could reasonably explain as a threat to exercise physical force
against the worker in workplace.

Policy and Requirements Policy #34 - Health, Safety and Environment

address workplace violence by including the definitions and requirements of the legislation
and applies to the entire campus communitry.

• The university is committed to maintaining a working and learning environment that is
violence free, strives to assess and minimize the risk of violence to ensure the reasonable
of safeguards are perfectly protecting the employees, students and visitors from incident
of violence on Universiry propety and events.

• The University has implemented a Workplace Violence Prevention Program, which
includes measures and precedures to protect employees, students and visitors, to ensure
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that Universiry employees have the appropriate information and instruction to protect
from violence in workplace.

• All employees, students and visitors ahve a responsibility in maintaining a violence
free working and learning environment by not engaging in acts of the violence and is
required to report the incidents.

• Any act of violence is unacceptable conduct that will not be tolerated. Anyone engaging
in activities of violation can be explused and banned from the University premises.

Domestic Violence The perpetrator and victim are in a personal relationship, such as a spouse
of former spouse.

Communication Under workplace violence legislation, empolyers and supervisors must also
provide the information to a worker about risk of the workplace violence from a person with
history if:

• the worker can expect to encounter that person in the course of work, and
• if the worker may be at risk of physical injury

In these cases, personal information may be disclosed.

Types and Sources Violence includes:

1. Threatening Behaviour - intimidate or threaten someone

• Physical intimidation - shaking fists, yelling in face
• Throwinf objects
• Destruction of property
• Verbal, written or electtonically transmitted threats to cause physical harm or damage

to perperty

1. Physical Attack - actual exercise of physical force or assaulting someone include:

• hitting
• pushing
• kicking
• punching
• use of a weapon A physical assault is important that behaviors associated with violence

are identified and addressed to prevent them from escalating into physical assault.

Risk Groups People who work in particular job

• Work with the general public
• Handle money
• Carry enforcement duties
• Provide counselling services
• Work with people under the influence of drugs or alcohol

Risk Assessment is the measurement for preparing the incidents

Preventive Measure measurement to reduce the likelihood of someone engaging in violent
behaviour. 1) workplace design - consider physical factors such as building security to reduce
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the opportunity for the theft and violence. 2) administrative practices - the procedures that
reduce the risks involved in handling cash or valuables. 3) work practices - individual groups
practices that protect your personal safety on a day-to-day basis.

3 Simulation fields

3.1 Compulational fluid dynamics (CFD) analysis

CFD is a branch field of fluid mechanics that combines numerical analysis and data structures
to solve and analyze problems that result on fluid flows scheme. Computers are used to
perform the calculations required to simulate the interaction of liquids and gases with surfaces
defined by boundary conditions. With high-speed supercomputers, better solutions can be
achieved. Ongoing research yields software that improves the accuracy and speed of complex
simulation scenarios such as transonic or turbulent flows. Initial experimental validation of
such software is performed using a wind tunnel with the final validation coming in full-scale
testing, e.g. flight tests.

3.1.1 Background and history of CFD

The fundamental basis of almost all CFD problems is the Navier-Stokes equations, which
define many single-phase (gas or liquid, but not both) fluid flows. These equations can be
simplified by removing terms describing viscous actions to yield the Euler equations. Further
simplification, by removing terms describing vorticity yields the full potential equations.
Finally, for small perturbations in subsonic and supersonic flows (not transonic or hypersonic)
these equations can be linearized to yield the linearized potential equations.

Historically, methods were first developed to solve the linearized potential equations. Two-
dimensional (2D) methods, using conformal transformations of the flow about a cylinder to
the flow about an airfoil were developed in the 1930s.

One of the earliest type of calculations resembling modern CFD are those by Lewis Fry
Richardson, in the sense that these calculations used finite differences and divided the
physical space in cells. Although they failed dramatically, these calculations, together with
Richardson’s book “Weather prediction by numerical process”, set the basis for modern CFD
and numerical meteorology. In fact, early CFD calculations during the 1940s using ENIAC
used methods close to those in Richardson’s 1922 book.

The computer power available paced development of three-dimensional methods. Probably
the first work using computers to model fluid flow, as governed by the Navier-Stokes equations,
was performed at Los Alamos National Lab, in the T3 group. This group was led by Francis H.
Harlow, who is widely considered as one of the pioneers of CFD. From 1957 to late 1960s, this
group developed a variety of numerical methods to simulate transient two-dimensional fluid
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flows, such as Particle-in-cell method (Harlow, 1957), Fluid-in-cell method (Gentry, Martin
and Daly, 1966), Vorticity stream function method (Jake Fromm, 1963), and Marker-and-
cell method (Harlow and Welch, 1965). Fromm’s vorticity-stream-function method for 2D,
transient, incompressible flow was the first treatment of strongly contorting incompressible
flows in the world.

The first paper with three-dimensional model was published by John Hess and A.M.O. Smith
of Douglas Aircraft in 1967. This method discretized the surface of the geometry with panels,
giving rise to this class of programs being called Panel Methods. Their method itself was
simplified, in that it did not include lifting flows and hence was mainly applied to ship hulls
and aircraft fuselages. The first lifting Panel Code (A230) was described in a paper written
by Paul Rubbert and Gary Saaris of Boeing Aircraft in 1968. In time, more advanced three-
dimensional Panel Codes were developed at Boeing (PANAIR, A502), Lockheed (Quadpan),
Douglas (HESS), McDonnell Aircraft (MACAERO), NASA (PMARC)and Analytical Methods
(WBAERO, USAERO and VSAERO). Some (PANAIR, HESS and MACAERO) were higher
order codes, using higher order distributions of surface singularities, while others (Quadpan,
PMARC, USAERO and VSAERO) used single singularities on each surface panel. The
advantage of the lower order codes was that they ran much faster on the computers of the
time. Today, VSAERO has grown to be a multi-order code and is the most widely used
program of this class. It has been used in the development of many submarines, surface ships,
automobiles, helicopters, aircraft, and more recently wind turbines. Its sister code, USAERO
is an unsteady panel method that has also been used for modeling such things as high speed
trains and racing yachts. The NASA PMARC code from an early version of VSAERO and a
derivative of PMARC, named CMARC, is also commercially available.

In the two-dimensional realm, a number of Panel Codes have been developed for airfoil
analysis and design. The codes typically have a boundary layer analysis included, so that
viscous effects can be modeled. Professor Richard Eppler of the University of Stuttgart
developed the PROFILE code, partly with NASA funding, which became available in the
early 1980s. This was soon followed by MIT Professor Mark Drela’s XFOIL code. Both
PROFILE and XFOIL incorporate two-dimensional panel codes, with coupled boundary
layer codes for airfoil analysis work. PROFILE uses a conformal transformation method for
inverse airfoil design, while XFOIL has both a conformal transformation and an inverse panel
method for airfoil design.

An intermediate step between Panel Codes and Full Potential codes were codes that used the
Transonic Small Disturbance equations. In particular, the three-dimensional WIBCO code,
developed by Charlie Boppe of Grumman Aircraft in the early 1980s has seen heavy use.

Developers turned to Full Potential codes, as panel methods could not calculate the non-linear
flow present at transonic speeds. The first description of a means of using the Full Potential
equations was published by Earll Murman and Julian Cole of Boeing in 1970. Frances Bauer,
Paul Garabedian and David Korn of the Courant Institute at New York University (NYU)
wrote a series of two-dimensional Full Potential airfoil codes that were widely used, the most
important being named Program H. A further growth of Program H was developed by Bob
Melnik and his group at Grumman Aerospace as Grumfoil. Antony Jameson, originally
at Grumman Aircraft and the Courant Institute of NYU, worked with David Caughey to
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develop the important three-dimensional Full Potential code FLO22 in 1975. Many Full
Potential codes emerged after this, culminating in Boeing’s Tranair (A633) code, which still
sees heavy use.

The next step was the Euler equations, which promised to provide more accurate solutions of
transonic flows. The methodology used by Jameson in his three-dimensional FLO57 code
(1981) was used by others to produce such programs as Lockheed’s TEAM program and
IAI/Analytical Methods’ MGAERO program. MGAERO is unique in being a structured
cartesian mesh code, while most other such codes use structured body-fitted grids (with
the exception of NASA’s highly successful CART3D code, Lockheed’s SPLITFLOW code
and Georgia Tech’s NASCART-GT). Antony Jameson also developed the three-dimensional
AIRPLANE code which made use of unstructured tetrahedral grids.

In the two-dimensional realm, Mark Drela and Michael Giles, then graduate students at
MIT, developed the ISES Euler program (actually a suite of programs) for airfoil design and
analysis. This code first became available in 1986 and has been further developed to design,
analyze and optimize single or multi-element airfoils, as the MSES program. MSES sees wide
use throughout the world. A derivative of MSES, for the design and analysis of airfoils in a
cascade, is MISES, developed by Harold “Guppy” Youngren while he was a graduate student
at MIT.

The Navier-Stokes equations were the ultimate target of development. Two-dimensional codes,
such as NASA Ames’ ARC2D code first emerged. A number of three-dimensional codes were
developed (ARC3D, OVERFLOW, CFL3D are three successful NASA contributions), leading
to numerous commercial packages.

3.1.2 Methodology

In all of these approaches the same basic procedure is followed.

During preprocessing

• The geometry and physical bounds of the problem can be defined using computer aided
design (CAD). From there, data can be suitably processed (cleaned-up) and the fluid
volume (or fluid domain) is extracted.

• The volume occupied by the fluid is divided into discrete cells (the mesh). The mesh
may be uniform or non-uniform, structured or unstructured, consisting of a combination
of hexahedral, tetrahedral, prismatic, pyramidal or polyhedral elements.

• The physical modeling is defined - for example, the equations of fluid motion + enthalpy
+ radiation + species conservation

• Boundary conditions are defined. This involves specifying the fluid behaviour and
properties at all bounding surfaces of the fluid domain. For transient problems, the
initial conditions are also defined.

The simulation is started and the equations are solved iteratively as a steady-state or transient.

Finally a postprocessor is used for the analysis and visualization of the resulting solution.
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Discretization methods

The stability of the selected discretisation is generally established numerically rather than
analytically as with simple linear problems. Special care must also be taken to ensure
that the discretisation handles discontinuous solutions gracefully. The Euler equations and
Navier-Stokes equations both admit shocks, and contact surfaces.

Some of the discretization methods being used are:

Finite volume method

The finite volume method (FVM) is a common approach used in CFD codes, as it has an
advantage in memory usage and solution speed, especially for large problems, high Reynolds
number turbulent flows, and source term dominated flows (like combustion).

In the finite volume method, the governing partial differential equations (typically the Navier-
Stokes equations, the mass and energy conservation equations, and the turbulence equations)
are recast in a conservative form, and then solved over discrete control volumes. This
discretization guarantees the conservation of fluxes through a particular control volume. The
finite volume equation yields governing equations in the form,

∂

∂t

∫∫∫
QdV +

∫∫
F dA = 0

, where $ Q$ is the vector of conserved variables, F is the vector of fluxes, $ V$ is the volume
of the control volume element, and $ A$ is the surface area of the control volume element.

Finite element method

The finite element method (FEM) is used in structural analysis of solids, but is also applicable
to fluids. However, the FEM formulation requires special care to ensure a conservative
solution. The FEM formulation has been adapted for use with fluid dynamics governing
equations. Although FEM must be carefully formulated to be conservative, it is much more
stable than the finite volume approach. However, FEM can require more memory and has
slower solution times than the FVM.

In this method, a weighted residual equation is formed:

Ri =
∫∫∫

WiQdV
e

where $ R_{i}$ is the equation residual at an element vertex $ i, Q $ is the conservation
equation expressed on an element basis, $ W_{i}$ is the weight factor, and V e is the volume
of the element.

Finite difference method

Main article: Finite difference method The finite difference method (FDM) has historical
importance and is simple to program. It is currently only used in few specialized codes, which
handle complex geometry with high accuracy and efficiency by using embedded boundaries
or overlapping grids (with the solution interpolated across each grid).
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∂Q

∂t
+ ∂F

∂x
+ ∂G

∂y
+ ∂H

∂z
= 0

where Q is the vector of conserved variables, and FF , GG, and HH are the fluxes in the xx,
yy, and zz directions respectively.

Spectral element method

Spectral element method is a finite element type method. It requires the mathematical
problem (the partial differential equation) to be cast in a weak formulation. This is typically
done by multiplying the differential equation by an arbitrary test function and integrating
over the whole domain. Purely mathematically, the test functions are completely arbitrary -
they belong to an infinite-dimensional function space. Clearly an infinite-dimensional function
space cannot be represented on a discrete spectral element mesh; this is where the spectral
element discretization begins. The most crucial thing is the choice of interpolating and testing
functions. In a standard, low order FEM in 2D, for quadrilateral elements the most typical
choice is the bilinear test or interpolating function of the form v(x, y) = ax+ by + cxy + d.
In a spectral element method however, the interpolating and test functions are chosen to
be polynomials of a very high order (typically e.g. of the 10th order in CFD applications).
This guarantees the rapid convergence of the method. Furthermore, very efficient integration
procedures must be used, since the number of integrations to be performed in numerical codes
is big. Thus, high order Gauss integration quadratures are employed, since they achieve the
highest accuracy with the smallest number of computations to be carried out. At the time
there are some academic CFD codes based on the spectral element method and some more
are currently under development, since the new time-stepping schemes arise in the scientific
world.

Boundary element method

In the boundary element method, the boundary occupied by the fluid is divided into a surface
mesh.

High-resolution discretization schemes

High-resolution schemes are used where shocks or discontinuities are present. Capturing
sharp changes in the solution requires the use of second or higher-order numerical schemes
that do not introduce spurious oscillations. This usually necessitates the application of flux
limiters to ensure that the solution is total variation diminishing.

Turbulence models

In computational modeling of turbulent flows, one common objective is to obtain a model
that can predict quantities of interest, such as fluid velocity, for use in engineering designs of
the system being modeled. For turbulent flows, the range of length scales and complexity of
phenomena involved in turbulence make most modeling approaches prohibitively expensive;
the resolution required to resolve all scales involved in turbulence is beyond what is com-
putationally possible. The primary approach in such cases is to create numerical models to
approximate unresolved phenomena. This section lists some commonly used computational
models for turbulent flows.
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Turbulence models can be classified based on computational expense, which corresponds
to the range of scales that are modeled versus resolved (the more turbulent scales that are
resolved, the finer the resolution of the simulation, and therefore the higher the computational
cost). If a majority or all of the turbulent scales are not modeled, the computational cost is
very low, but the tradeoff comes in the form of decreased accuracy.

In addition to the wide range of length and time scales and the associated computational
cost, the governing equations of fluid dynamics contain a non-linear convection term and a
non-linear and non-local pressure gradient term. These nonlinear equations must be solved
numerically with the appropriate boundary and initial conditions.

Reynolds-averaged Navier-Stokes

Reynolds-averaged Navier-Stokes (RANS) equations are the oldest approach to turbulence
modeling. An ensemble version of the governing equations is solved, which introduces new
apparent stresses known as Reynolds stresses. This adds a second order tensor of unknowns
for which various models can provide different levels of closure. It is a common misconception
that the RANS equations do not apply to flows with a time-varying mean flow because these
equations are ‘time-averaged’. In fact, statistically unsteady (or non-stationary) flows can
equally be treated. This is sometimes referred to as URANS. There is nothing inherent in
Reynolds averaging to preclude this, but the turbulence models used to close the equations are
valid only as long as the time over which these changes in the mean occur is large compared
to the time scales of the turbulent motion containing most of the energy.

RANS models can be divided into two broad approaches:

Boussinesq hypothesis

This method involves using an algebraic equation for the Reynolds stresses which include
determining the turbulent viscosity, and depending on the level of sophistication of the model,
solving transport equations for determining the turbulent kinetic energy and dissipation.
Models include k-?? (Launder and Spalding), Mixing Length Model (Prandtl), and Zero
Equation Model (Cebeci and Smith). The models available in this approach are often referred
to by the number of transport equations associated with the method. For example, the
Mixing Length model is a “Zero Equation” model because no transport equations are solved;
the k − ε is a “Two Equation” model because two transport equations (one for k and one for
ε ) are solved.

Reynolds stress model (RSM)

This approach attempts to actually solve transport equations for the Reynolds stresses. This
means introduction of several transport equations for all the Reynolds stresses and hence
this approach is much more costly in CPU effort.

Large eddy simulation

Volume rendering of a non-premixed swirl flame as simulated by LES.

Large eddy simulation (LES) is a technique in which the smallest scales of the flow are
removed through a filtering operation, and their effect modeled using subgrid scale models.
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This allows the largest and most important scales of the turbulence to be resolved, while
greatly reducing the computational cost incurred by the smallest scales. This method requires
greater computational resources than RANS methods, but is far cheaper than DNS.

Detached eddy simulation

Detached eddy simulations (DES) is a modification of a RANS model in which the model
switches to a subgrid scale formulation in regions fine enough for LES calculations. Regions
near solid boundaries and where the turbulent length scale is less than the maximum grid
dimension are assigned the RANS mode of solution. As the turbulent length scale exceeds
the grid dimension, the regions are solved using the LES mode. Therefore, the grid resolution
for DES is not as demanding as pure LES, thereby considerably cutting down the cost of
the computation. Though DES was initially formulated for the Spalart-Allmaras model
(Spalart et al., 1997), it can be implemented with other RANS models (Strelets, 2001), by
appropriately modifying the length scale which is explicitly or implicitly involved in the RANS
model. So while Spalart-Allmaras model based DES acts as LES with a wall model, DES
based on other models (like two equation models) behave as a hybrid RANS-LES model. Grid
generation is more complicated than for a simple RANS or LES case due to the RANS-LES
switch. DES is a non-zonal approach and provides a single smooth velocity field across the
RANS and the LES regions of the solutions.

Direct numerical simulation

Direct numerical simulation (DNS) resolves the entire range of turbulent length scales.
This marginalizes the effect of models, but is extremely expensive. The computational
cost is proportional to Re3. DNS is intractable for flows with complex geometries or flow
configurations.

Coherent vortex simulation

The coherent vortex simulation approach decomposes the turbulent flow field into a coherent
part, consisting of organized vortical motion, and the incoherent part, which is the random
background flow. This decomposition is done using wavelet filtering. The approach has
much in common with LES, since it uses decomposition and resolves only the filtered portion,
but different in that it does not use a linear, low-pass filter. Instead, the filtering operation
is based on wavelets, and the filter can be adapted as the flow field evolves. Farge and
Schneider tested the CVS method with two flow configurations and showed that the coherent
portion of the flow exhibited the −40

39 energy spectrum exhibited by the total flow, and
corresponded to coherent structures (vortex tubes), while the incoherent parts of the flow
composed homogeneous background noise, which exhibited no organized structures. Goldstein
and Vasilyev applied the FDV model to large eddy simulation, but did not assume that
the wavelet filter completely eliminated all coherent motions from the subfilter scales. By
employing both LES and CVS filtering, they showed that the SFS dissipation was dominated
by the SFS flow field’s coherent portion.

PDF methods

Probability density function (PDF) methods for turbulence, first introduced by Lundgren, are
based on tracking the one-point PDF of the velocity, fV (v; x, t)dv, which gives the probability
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of the velocity at point x being between v and v + dv. This approach is analogous to the
kinetic theory of gases, in which the macroscopic properties of a gas are described by a large
number of particles. PDF methods are unique in that they can be applied in the framework
of a number of different turbulence models; the main differences occur in the form of the
PDF transport equation. For example, in the context of large eddy simulation, the PDF
becomes the filtered PDF. PDF methods can also be used to describe chemical reactions.
and are particularly useful for simulating chemically reacting flows because the chemical
source term is closed and does not require a model. The PDF is commonly tracked by using
Lagrangian particle methods; when combined with large eddy simulation, this leads to a
Langevin equation for subfilter particle evolution.

Vortex method

The vortex method is a grid-free technique for the simulation of turbulent flows. It uses
vortices as the computational elements, mimicking the physical structures in turbulence.
Vortex methods were developed as a grid-free methodology that would not be limited by the
fundamental smoothing effects associated with grid-based methods. To be practical, however,
vortex methods require means for rapidly computing velocities from the vortex elements - in
other words they require the solution to a particular form of the N-body problem (in which
the motion of N objects is tied to their mutual influences). A breakthrough came in the
late 1980s with the development of the fast multipole method (FMM), an algorithm by V.
Rokhlin (Yale) and L. Greengard (Courant Institute). This breakthrough paved the way to
practical computation of the velocities from the vortex elements and is the basis of successful
algorithms. They are especially well-suited to simulating filamentary motion, such as wisps
of smoke, in real-time simulations such as video games, because of the fine detail achieved
using minimal computation.

Software based on the vortex method offer a new means for solving tough fluid dynamics
problems with minimal user intervention. All that is required is specification of problem
geometry and setting of boundary and initial conditions. Among the significant advantages
of this modern technology;

It is practically grid-free, thus eliminating numerous iterations associated with RANS and
LES. All problems are treated identically. No modeling or calibration inputs are required.
Time-series simulations, which are crucial for correct analysis of acoustics, are possible. The
small scale and large scale are accurately simulated at the same time.

Vorticity confinement method

The vorticity confinement (VC) method is an Eulerian technique used in the simulation of
turbulent wakes. It uses a solitary-wave like approach to produce a stable solution with no
numerical spreading. VC can capture the small-scale features to within as few as 2 grid
cells. Within these features, a nonlinear difference equation is solved as opposed to the finite
difference equation. VC is similar to shock capturing methods, where conservation laws are
satisfied, so that the essential integral quantities are accurately computed.

Linear eddy model

The Linear eddy model is a technique used to simulate the convective mixing that takes place
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in turbulent flow. Specifically, it provides a mathematical way to describe the interactions
of a scalar variable within the vector flow field. It is primarily used in one-dimensional
representations of turbulent flow, since it can be applied across a wide range of length scales
and Reynolds numbers. This model is generally used as a building block for more complicated
flow representations, as it provides high resolution predictions that hold across a large range
of flow conditions.

Two-phase flow

Simulation of bubble swarm using volume of fluid method The modeling of two-phase flow
is still under development. Different methods have been proposed, including the Volume
of fluid method, the Level set method and front tracking. These methods often involve a
tradeoff between maintaining a sharp interface or conserving mass. This is crucial since the
evaluation of the density, viscosity and surface tension is based on the values averaged over
the interface. Lagrangian multiphase models, which are used for dispersed media, are based
on solving the Lagrangian equation of motion for the dispersed phase.

Solution algorithms Discretization in the space produces a system of ordinary differential
equations for unsteady problems and algebraic equations for steady problems. Implicit or
semi-implicit methods are generally used to integrate the ordinary differential equations,
producing a system of (usually) nonlinear algebraic equations. Applying a Newton or Picard
iteration produces a system of linear equations which is nonsymmetric in the presence of
advection and indefinite in the presence of incompressibility. Such systems, particularly in
3D, are frequently too large for direct solvers, so iterative methods are used, either stationary
methods such as successive overrelaxation or Krylov subspace methods. Krylov methods
such as GMRES, typically used with preconditioning, operate by minimizing the residual
over successive subspaces generated by the preconditioned operator.

Multigrid has the advantage of asymptotically optimal performance on many problems.
Traditional solvers and preconditioners are effective at reducing high-frequency components
of the residual, but low-frequency components typically require many iterations to reduce.
By operating on multiple scales, multigrid reduces all components of the residual by similar
factors, leading to a mesh-independent number of iterations.

For indefinite systems, preconditioners such as incomplete LU factorization, additive Schwarz,
and multigrid perform poorly or fail entirely, so the problem structure must be used for
effective preconditioning. Methods commonly used in CFD are the SIMPLE and Uzawa
algorithms which exhibit mesh-dependent convergence rates, but recent advances based on
block LU factorization combined with multigrid for the resulting definite systems have led to
preconditioners that deliver mesh-independent convergence rates.

Unsteady aerodynamics

CFD made a major break through in late 70s with the introduction of LTRAN2, a 2-D code
to model oscillating airfoils based on transonic small perturbation theory by Ballhaus and
associates. It uses a Murman-Cole switch algorithm for modeling the moving shock-waves.
Later it was extended to 3-D with use of a rotated difference scheme by AFWAL/Boeing
that resulted in LTRAN3.
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Biomedical engineering

Simulation of blood flow in a human aorta

CFD investigations are used to clarify the characteristics of aortic flow in detail that are
otherwise invisible to experimental measurements. To analyze these conditions, CAD models
of the human vascular system are extracted employing modern imaging techniques. A 3D
model is reconstructed from this data and the fluid flow can be computed. Blood properties
like Non-Newtonian behavior and realistic boundary conditions (e.g. systemic pressure) have
to be taken into consideration. Therefore, making it possible to analyze and optimize the
flow in the cardiovascular system for different applications.

CPU versus GPU Traditionally, CFD simulations are performed on CPU’s. In a more recent
trend, simulations are also performed on GPU’s. These typically contain slower but more
processors. For CFD algorithms that feature good parallellisation performance (i.e. good
speed-up by adding more cores) this can greatly reduce simulation times. Lattice-Boltzman
methods are a typical example of codes that scale well on GPU’s.

4 Project background

My work involves the simulation of fluid from the object which uses computational fluid
dynamic (CFD) analysis to simulate an antibiotic drug release profile by the given mathe-
matical model. To consistly simplify and comapare the release profiles, the mathematical
model will present in this form,

Mt

M∞
= 1− e−ax−b

Where Mt
M∞ refers to mass release at the time point over the total mass release, a and b refers

constant. This equation will be compared in the Chapter 2.
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Part II

Training Activities

5 Background

5.1 Project background

From previous works, the center of interest of orthopedic surgery includes the development of
drug eluting from orthopedic implant. One of the branch in medical treatments for athritis
symptoms is also Osteoarthritis. By the increaseing of the patients, a well-known orthopedic
surgery to recover this symptoms is hip arthroplasty or hip replacement. The development
is getting the emphasize on when we insert the the artificial joint (implants) to our body,
bacteria from the surrounding can come along with even the instrtments have been sterilized.
To protect our body, many researches try to add or coat antibiotics drug to the implant parts.
The simulation project aims to stimulate the controlled-release of antibiotics drugs from the
implant parts.

Figure 3: Hip joint replacement, A.D.A.M. Health Encyclopedia
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The new hip that replaces the old one is made up of these parts:

• Acetabular Cup or a socket, which is usually made of strong metal.
• Polyethylene Insert, which fits inside the socket. It is most often polymer form.
• Femoral Head, this part is artificial part of your thigh bone.
• Neck and femoral stem are attached to the thigh bone to anchor the joint.

Figure 4: Hip replacement parts

The previous work used Vancomycin as an antibiotics drug stores in reservior inside the coated
plastic surface geometry. The plastic is formed by poly-L-lactic acid (PLLA) polymer. On this
project, we will study release profile of vancomycin through PLLA layer by Compulational
Fluid Dynamics (CFD) analysis based on the properties of PLLA and the types of orthopedic
implants.

From the objective of the studies, to find the vancomysin release profile from various surface
object. I translate the complicated shape as in Figure 4 to the simple forms. The simple
geometry for the controlled-release are sphere, half-sphere and cylinder respectively as shown
in Figure 5.
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Figure 5: Model geometry: shpere, half-sphere and cylinder surface models

We will use these principle shapes to simulate the fluid flow by using ANSYS software. Then,
we can design the vancomysin delivery from various types of orthopedic implants. Surface of
the implants will be coated by containing thin surface of vancomysin reservior.

Figure 6: Surface geometry is coated by PLLA

From the previous studies, they conducted in vitro study of release profile, And, the graph
between time(h) and release percentage(%) are shown below.
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For experiment A (red line), the mathematical model shown as,

Mt

M∞
= 1− e−0.105x−1.110

.

From experiment B (blue line), the mathematical model shown as,

Mt

M∞
= 1− e−0.009x−0.116

. This is the desirable mathematical model for drug diffusion

The result from experiment A defined as undesirable brust relase that only release on 3 days.
They would like to extend the release profile up to 20 days as experiment B.

Solving brust release problem, previous works incresed the release time by:

• adding multi-layer of polymer coat. [1]
• modify polymer composition, or trying other materials, like ceramic or metal. [2]

We will find the best vancomysin release profile from various orthopedic implants and the
properties of polymer cost by computational fluid dynamic (CFD) simulation.
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5.2 Fundamental Mechanisms

Assume we have a metal sphere, it is coated by the polymer that contain antibiotics drug (A)
at the head joint of the bone.

Figure 7: drug diffusion out of the spherical surface

The drug-release through the polymer to environment liquid. Assume we have the uniform
concentration as CAo. The system assume to be steady state condition which is in = out.
The coat is infiniteimal thin.

Chemical formula of the system, as shown when the drug diffusion from inside A to outside
and then the compound react with the blood formed to be B

A→ B
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5.2.1 Shell balance

From the system, the drug only diffusion to outside direction of the sphere. Assume the
thickness of the coat is constant.

Material balance: NAr(Aπr2)
∣∣∣∣
r+δ

= 0

When δ → 0

d

dr
(NArr

2) = 0

From Fick’s first law of diffustion, the equimolar counter-diffustion states the flux as NAr =
−Dab

dc
dr

Boundary conditions are stated as

• at r = R, concentration CA = 0
• at r = R + δ, concentration CA = CAo

d
dr

(−Dab
dc
dr
r2) = 0∫ r

0
d
dr

(−Dab
dc
dr
r2)dr =

∫ r
0 0dr

−Dab
dc
dr

= C1

−Dab
dc
dr

= C1
r2

−Dab
1
C1
dCA = 1

r2dr∫ CA
0 −Dab

1
C1
dCA =

∫ r
0

1
r2dr

CA
C1

= −1
r

+ C2

CA = −C1

r
+ C2

Applies to boundary conditions:

• at
r = R→ 0 = −C1

r
+ C2 (1)

• at
r = R + δ → 0 = − C1

R + δ
+ C2 (2)

(1)− (2) :
C1 = R

δ
(R + δ)CAo

C2 = 1
δ

(R + δ)CAo
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CA = −R(R + δ)CAo
rδ

+ 1
δ

(R + δ)CAo
CA
CAo

= −1
r

(R + δ)(1− R

r
)
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5.2.2 Diffustion eluting out of the sphere

By the process diffusion limited drug delivery

A spherical hip joint that contains antibiotics is controlled drug-release form the coat which
can be assumed by the uniform concentration of the drug around the sphere.

By combing continuity equation with Fick’s law of diffusion
∂CA
∂t

+∇NA = RA (reaction)

Assume antibiotics drug does not change the form by diffusion, the equation has no reaction.

∇NA = 1
r2

∂
∂r

(r2NA,r) + 1
r sin θ

∂
∂θ

(NA,θ sin θ) + 1
r sinφ

∂NA,φ
∂φ

(NA,φ)
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the concentrations over θ and φ coordinates are constant over the time.

So, ∇NA = 1
r2

∂
∂r

(r2NA,r)
∂CA
∂t

+ 1
r2

∂
∂r

(r2NA,r) = 0

From Fick’s second law of diffusion

NA,r = −cDyA∇yA + yA(NA +NB)

where equimolar concentration of A and B, NA +NB = 0

NA,r = −CDyA
∂yA
∂r

yA = CA
C
→ dyA

dr
= 1

C
dCA
dr

NA,r = −CDyA
1
C
dCA
dr

∂CA
∂t
− 1

r2
∂
∂r

(r2DyA
dCA
dr

) = 0

∂CA
∂t

= DyA

∂2CA
dr2

By initial condition is t = 0 for all r, CA = CAo

And boundary conditions are,

When
t > 0, r = R,CA = CAo

t > 0, r = 0, dCA
dr

= 0

Solving diffustion equation,

Assume that:

CA(r, t) = R(r)T (t)

Differentiating, ∂CA
∂t

= R∂T
∂t

∂sCA
∂r2 = T ∂2R

∂r2

So, R∂T
∂t

= T ∂2R
∂r2

1
T

∂T

∂t
= 1
R

∂2R

∂r2 = k

In this case, k prefers to be −λ2

1
T
∂T
∂t

= −λ2

T = Ae−λ
2t———-(1)

1
R
∂2R
∂r2 = −λ2
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R = B cos(λr) + C sin(λr)———(2)

From, CA(r, t) = R(r)T (t) = (1)× (2)

So, CA(r, t) = Ae−λ
2t[B cos(λr) + C sin(λr)]

CA(r, t) = e−λ
2t[C1 cos(λr) + C2 sin(λr)]

D <- 1
Q <- 1
Cext <- C

plot (Grid$x.mid, Spherical$y, type = "l", main = "Steady State Diffustion", lwd = 3, xlab = "r", ylab = "C", col = "darkgreen", lty = 1)
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Steady State Diffustion

r

C

## user system elapsed
## 0.22 0.03 0.25

## time 1 2 3
## [99,] 98 83.32220 83.32222 83.32228
## [100,] 99 83.32325 83.32327 83.32334
## [101,] 100 83.32420 83.32423 83.32429

image(out, grid = Grid$x.mid, xlab = "time, days",
ylab = "Distance, cm", main = "Steady State Diffustion PDE", add.contour = TRUE)
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Therefore, from this plot we can conclude that our antibiotics drug will last for 30 days.
That’s all for one dimension analysis.

5.2.3 Spherical diffusion steady state and non-steady state diffusion

Steady state From
When dCA

dr = 0,
Cs = ax+ b

6 Literature Review

6.1 Modeling of diffusion controlled drug delivery [Review] [3]

Main work of this paper summarizes mathematical model for slab, cylindrical,
spherical shape.
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This papers introduces the realistic mathematical description of drug release
kinetics based on controlled parameters. From particular type of dosage forms
which are slab, sphere and cylinder, the kinetic simulation allow for safety of
treatment, quantitative prediction of the drug by its eluting effects.
The rate limiting step of the drug eluting is the slowest rate in mass trans-
port processes. This work emphasized the art of mathematical modeling of
predominently diffusion controlled drug delivery system, which can referred
as the term “diffustion controlled” in the system that limited drug controlled.

Figure 8: Siepmann J and Siepmann F models

They reviewd the moddels of diffusion controlled-drug from the different
reservior devices and activity sources.
From the desired meodel that related to our simulation, core-shell structure
model suit to the work. Core-shell structure includes the condition constant
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activity source and non-constant activity source. This model will be the
standard reference of the resulted model.

7 ANSYS Engineering Software for Simulation

Figure 9: ANSYS, Inc. logo

ANSYS is engineering simulaiton and 3D design software which to simulate
modeling solution for any engineering problems. The software has capability
to create general computer models of structures, electronics and machine
components. ANSYS gives the output in many form of calculations, which
are toughness, elasticciry, temperature distribution, strength of materials,
pressure distribution, fluid flow, etc.
Generally, ANSYS is used to prior calculation with the propose of determining
how the system will fuction with different specifications. The advantage of
ANSYS simulaton is the experiment will not conduct the crash tests or real
test product, which will beneficially decrease the cost of production.

8 Setting up the experiments

I set up the experiment on ANSYS by two big conditions;
• 2D cylinder model analysis
• 3D sphere model analysis
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Figure 10: 2D model

Figure 11: Hip head CAD
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8.1 Set up experiments on 2D analysis

8.1.1 General set up for all experiment

In ANSYS, I set up these conditions as for every simulation
Pressure = 101,325 Pa
Gravity = -9.81 m/s2 in y-direction
Time = transient

8.2 Method of calculation

PISO method will be used in the calcultion
PISO of Pressure-Implicit with Splitting of Operators method was proposed by
Issa in 1986 without iterations and with large time steps and a lesser computing
effort. It is an extension of the SIMPLE algorithm used in computational fluid
dynamics (CFD) to solve the Navier-Stokes equations. PISO is a pressure-
velocity calculation procedure for the Navier-Stokes equations developed
originally for non-iterative computation of unsteady compressible flow, but it
has been adapted successfully to steady-state problems.
Algorithm Steps
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Figure 12: Flow chart of PISO algorithm

The algorithm can be summed up as follows:
1. Set the boundary conditions.
2. Solve the discretized momentum equation to compute an intermediate

velocity field.
3. Compute the mass fluxes at the cells faces.
4. Solve the pressure equation.
5. Correct the mass fluxes at the cell faces.
6. Correct the velocities on the basis of the new pressure field.
7. Update the boundary conditions.
8. Repeat from 3 for the prescribed number of times.
9. Increase the time step and repeat from 1.

As already seen for the SIMPLE algorithm, the steps 4 and 5 can be repeated
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for a prescribed number of times to correct for non-orthogonality.

8.2.1 Advantages and disadvantages of PISO method

1. Generally gives more stable results and takes less CPU time but not
suitable for all processes.

2. Suitable numerical schemes for solving the pressure-velocity linked equa-
tion.

3. For laminar backward facing step PISO is faster than SIMPLE but it is
slower concerning flow through heated fin.

4. If momentum and scalar equation have weak or no coupling then PISO
is better than SIMPLEC.

8.3 Models

I setting up the models of the simulation as

8.3.1 Multi-phase - 2 phases; blood, drug, with no interaction.

The VOF Model

The VOF model is a surface-tracking technique applied to a fixed Eulerian
mesh. It is designed for two or more immiscible fluids where the position of
the interface between the fluids is of interest. In the VOF model, a single
set of momentum equations is shared by the fluids, and the volume fraction
of each of the fluids in each computational cell is tracked throughout the
domain. Applications of the VOF model include stratified flows, free-surface
flows, filling, sloshing, the motion of large bubbles in a liquid, the motion of
liquid after a dam break, the prediction of jet breakup (surface tension), and
the steady or transient tracking of any liquid-gas interface.
The experiment was used VOF model for CFD analysis.
Step for setting up multiphase model
1. Enable the multiphase model you want to use (VOF, mixture, or Eulerian)

and specify the number of phases. For the VOF and Eulerian models,
specify the volume fraction scheme as well.
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On trees tap Model → Muliphase → Edit....

8.3.2 Species transport - investigating drug flow

Mass Diffusion in Laminar Flows

When you choose to solve conservation equations for chemical species, ANSYS
Fluent predicts the local mass fraction of each species, , through the solution of
a convection-diffusion equation for the th species. This conservation equation
takes the following general form:

Ji = −ρDi,m∇Yi −DT,i
∇T
T

Where Yi refers to local mass fraction of each species, Di,m refers to the
mass diffusion coefficient for species i in the mixture, and DT,i is the thermal
diffusion coefficient.
Diffusion at Inlets

For the pressure-based solver in ANSYS Fluent, the net transport of species at
inlets consists of both convection and diffusion components. For the density-
based solvers, only the convection component is included. The convection
component is fixed by the inlet species mass fraction specified by you. The
diffusion component, however, depends on the gradient of the computed
species field at the inlet. Thus the diffusion component (and therefore the net
inlet transport) is not specified a priori.
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9 Results

9.1 Intial trials simulation

Figure 13: Initial simulation from the source
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9.2 Controlling velocity inlets

By the result of solving burst effect consequence to the velocity of the diffusion
inlet.
Control condtions

Control drug velocity from
• 2.778x10−7m/s or 1mm/hr
• 5.555x10−8m/s

and fix density at 100m/s [from the standard of antibiotic drug density]
Results

Velocity control results
Conditions Value Equations
Velocity-1 2.778x10−7m/s Mt

M∞
= 1− e−0.0021x−0.00000096

Velocity-2 5.555x10−7m/s Mt

M∞
= 1− e−0.015x−0.003587

Table 2: Velocity control results

Figure 14: Graph of velocity control result
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Figure 15: Velocity-1 simulation
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Figure 16: Velocity-2 simulation

9.3 Controlling density of fluids

By the result of solving burst effect consequence to the velocity of the diffusion
inlet.
Control condtions

Control drug velocity from
• 100kg/m3

• 500kg/m3

• 1000kg/m3

and fix density at 1449.2kg/m3 [from the standard of antibiotic drug density]
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Results

Density control results
Conditions Value Concentration Equations
Density-1 100kg/m3 0.069mol/m3 Mt

M∞
= 1− e−0.015x−0.003587

Density-2 500kg/m3 0.345mol/m3 Mt

M∞
= 1− e−0.0045x−0.000105

Density-3 1000kg/m3 0.690mol/m3 Mt

M∞
= 1− e−0.001x−0.00000015

Table 3: Velocity control results

Figure 17: Graph of velocity control result
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Figure 18: Density-1 simulation
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Figure 19: Density-2 simulation
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Figure 20: Density-3 simulation

9.4 Vancomycin properties

The density of vancomycin in 1mol is 1449.2kg/m3
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Figure 21: Vancomycin properties simulation
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9.5 Reaction on drug and blood

Controls by mass transfer between blood to drug is 0.005 per hour. Equation
of reaction 1 is

Mt

M∞
= 1− e−0.009x−0.0.000002387

Figure 22: Reaction blood-drug simulation
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Figure 23: Reaction blood-drug simulation

9.6 Add pseudo-layer of polymer

I try the experiment on adding polymer layers.
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Control condtions

Try to add layer thickness from
• 0.001mm
• 1mm

Results

control results
Conditions Value Equations
Layer-1 0.001mm Mt

M∞
= 1− e−0.58x−0.000023

Layer-2 1mm Mt

M∞
= 1− e−0.038x−0.000012

Table 4: Peudolayer results

Figure 24: Graph of layer result
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Figure 25: Layer-1 simulation
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Figure 26: Layer-2 simulation
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9.7 3D analysis

9.7.1 Shpere

Figure 27: 3D sphere equation
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Figure 28: sphere-1 simulation
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Figure 29: sphere-2 simulation
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9.7.2 Cylinder

Figure 30: cylinder equation
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Figure 31: cylinder-1 simulation
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10 Verification

Figure 32: Based on KMUTT model

Figure 33: Based on theoretical model
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Figure 34: Based on Siepmann J model
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Part III

Knowledge and gained from training

11 Research skills

I have gained the high-level of research from the training at the University of
Waterloo. Research environment there induces me to learn how to effectively
uses the knowledge for the whole three years that I have studied from SIIT.
Department of Chemical Engineering of UW opens my mind about the research
field that I have ever seen before. I have familiar with the people who is an
expert only specific area such as CFD in chemical engineering on process
analysis. Moreover, I have known that I can do the challenging project by
learning hardly by myself to recognize genuinely in the project.

12 Simulations

I increase my skills in drawing 3D CAD. For the software, I have used ANSYS
program for analyzing the process. In the University of Waterloo, they
emphasize the field of the simulation process. Because of computer-based
research can predict and estimate the risk before taking a test. To research
this field, correctly simulation is critical. Moreover, from the internship there
I have tried to reasonable link between the theoretical assumption and the
simulation.
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Part IV

Comments and recommendations

I would really like to recommend the training in the University of Waterloo.
The work is very appropriate for chemical Engineering proved by I would state
that the knowledge from SIIT was totally paying off during an internship by
design experiment on the research and explain deeply on the results meaning.
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Appendix

A Appendices

A.1 2D diffusion modeling on drug eluting out of sphere

A.1.1 Introduction

In this modeling, the mixture of blood-drug model in ANSYS fluent is the
main fluid used in this system. First, the flows are set up as continuous phase
model. I use the lastest version of ANSYS product which is ANSYS 19.0.

Step 1 Start the project in ANSYS workbench. Open the window by click on
the workbench icon as shown in Figure 35.

Figure 35: ANSYS workbench

The window of the ANSYS workbench will show as in Figure 36.
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Figure 36: Step 1

On Analysis System Select Fluid Flow (Fluent) on the left tap bar, drag
the icon to the Project Schematic area(Figure A.1.1)
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Figure 37: Hold on the left click and pull in to the Project Schematic area

When you hold the left click and drag the Fluent ion to the right hand side,
the red rectange with the sentence,Create Standalone s, will show on the
project schematic area as shown in Figure 38
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Figure 38: the red rectange with the sentence, ‘Create Standalone s‘ show the area that the
work would be done in series on the workbench

Push the left click up. The rectangle of Fluent part will pop up as shown this
Figure 39.
(Optional) Change the project name, in my case, I change the project name
to be 2D_sphere.
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Figure 39: The Fluent options and controls are orderly shown as this rectangular box

Figure 40: Save a project by click on a save symbol as indicated

Save the project Click on the savesymbol as point in Figure 40 or click
File → Save As... → Name.wbpj → Save button.
In my case, I change the project to 2D_sphere_diffusion
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Step 2 Create geometry of the system fluid flow.
Double cick on the tap of Geometry.

Figure 41: Next step input geometry of the object, click on the geometry tap on the Fluent
control bar

The window of ANSYS program names SpaceClaim 19.0 or DesignModeler
19.0 will pop up for drwing an object.
For this simulation, I used SpaceClaim 19.0. (I will explain how to use both
SpaceClaim 19.0 and DesignModeler 19.0 in sequence in Appendix part)
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Figure 42: SpaceClaim 19.0 window

Click Close on ANSYS SpaceClaim direct modeler
Start to draw the desired geometry. In my case, I start to draw the circle as
the hip joint metal by the diameter of 20cm, the circle of the polymer coated
the metal joint by diameter 23cm and the rectangular as the blood flow area
enclose the the hip joint and polymer by the 40× 100 scale.
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Figure 43: Sketeh the the desired geometry in SpaceClaim 19.0

Figure 44: Details on geometry

Saving the SCDM project by Click on the savesymbol or click File →
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Save As... → Name.scdoc → Save button.
Close SpaceClaim window and reopen your project Workbench window.

Figure 45: Project control in ANSYS Workbench

Now, we can notice the Check sign on geometry tab Figure 45, which mean
that this geometry is appropriate.
In case of the change in geometry configurations, the tab of geometry will show
the thunder symbol, click on the left click and → Update as in Figure 46
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Figure 46: Click on update geometry

if the geometry is appropriate, the workbench will change the sign to Figure 47.

Figure 47: Change of the sign notify that the program can continue the process

Next, On the right hand side in the options of properties of schematic A2:
Geometry, change the Analysis type on the row 12 into 2D (in case of 2
dimension).
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Figure 48: Change Analysis type

Step 3 Create mesh in the object.
Meshing

Meshing is the process that generates the small parts of the object by dividing
the whole component into a number of element (finite element analysis).
The more mesh influences the more accuracy, convergence, and speed of the
solution. Creating the appropriate number of mesh is necessary in engineering
simulation. Therefore, The better and more automated the meshing tools,
the better the solution.
Double click on mesh tab on the below of geometry tab as in Figure 45.
The Meshing Window will pop up as in Figure 49
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Figure 49: Change Analysis type

Generate a mesh on the object by right click on thunder symbol Mesh →
click Generate Mesh
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Figure 50: Generate a mesh on the object

After that the program will run to generate the mesh as in Figure 51
Control the size of the mesh by the tab Sizing on the Details of Mesh,
click on Max Face Size change it to the smallest number as you want. I
change to 0.0003. Next, right click on Mesh → click Update
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Figure 51: Generate a mesh on the object

Figure 52: The mesh is generated

Now, we finish meshing process. Close meshing window and reopen the
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workbench. In workbench, right click on thunder symbol mesh and → click
Update

The thunder symbol will change to check symbol as shown in Figure 53.

Figure 53: The mesh is appropriate and the process can continue

Named sections

I will name the section by Figure 54 zones.
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Figure 54: Name the section

For name each sections, Choose the selection tool on the above tab.

Figure 55: Selection region tools

After you select the region on the object, click right → Create Named
Selection as in Figure 56
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Figure 56: Create name selection

Create the region name.

Figure 57: Create name selection
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Finish name sections, close the Meshing window, click on thunder symbol
Mesh rightarrow Update.

Step 4 Set up ANSYS Fluent

Double click on Set up in Figure 53. ANSYS Fluent option will pop up as in
??.
Select:
Dimension → 2D
Processing Options → serial
Options → Double Precision,
Leave other as the same, Click OK

ANSYS software will pop up as in the window

Figure 58: ANSYS Fluent window

In Fluent window (Figure 59), the program set up to have two control spaces,
the first zone is the above of window which qualify the type of control such
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as Setting Up Domain, Setting Up Physics, User defied, so on. Second
zone controls can be accessed in the middle of the window, which correspond to
the lists on the left and in the workbench such as Set up, Solution, Result,
so on.

Figure 59: ANSYS Fluent window and control area

Begin Set up

1. Setting up domain In setting up the domain, you will check the mesh-
related properties
Change the units

Clicking Setting Up Domain → Mesh → Units. In my case, I will change
the units length from m to mm
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Check the mesh

Clicking Setting up Domain → Mesh → Check

The values of the mesh will report in the console.
## Domain Extents:
## x-coordinate: min (m) = -1.951386e-02, max (m) = 2.048614e-02
## y-coordinate: min (m) = -4.973950e-02, max (m) = 5.026050e-02
## Volume statistics:
## minimum volume (m3): 3.356570e-09
## maximum volume (m3): 8.400654e-08
## total volume (m3): 4.000000e-03
## Face area statistics:
## minimum face area (m2): 9.167062e-06
## maximum face area (m2): 4.132829e-04
## Checking mesh...........................
## Done.

If the errors on the mesh occur, it will be reported in this step. And, ensure
that minimum volume is not negative because ANSYS Fluent cannot begin
the calculation.
Review the mesh quality

ANSYS Fluent will report the mesh quality in the console.
## Minimum Orthogonal Quality = 9.46787e-01 cell 314 on zone 4
## (ID: 90748 on partition: 0) at location (-2.89720e-03 -4.34247e-03)
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## (To improve Orthogonal quality , use "Inverse Orthogonal Quality"
## in Fluent Meshing, where Inverse Orthogonal
## Quality = 1 - Orthogonal Quality)
##
## Maximum Aspect Ratio = 1.62824e+01 cell 318 on zone 4
## (ID: 90752 on partition: 0) at location (-2.83154e-03 -4.51415e-03)

Minimum cell orthogonality is an important indicator of mesh quality (vary
from 0 to 1), which the lower values indicating the poorer quality cells. In our
case, Minimum Orthogonal Quality = 0.946787, which can refer to a good
quality. Generally the minimum orthogonality should not be below 0.01 on
the average. For maximum aspect ratio, the higher ratio in cell refer to a
result of boundary layer inflation in the meshing step.
2. Setting up physics

In this step, we will control the properties in a solver.
Clicking on Setting Up Physics → Solver

we will set the properties as

Type → Density-based coupled solver (DBCS) ; because major aim of our
process is performed by quality of mass transfer. In this case, DBCS method
initializes the equation from continuity, momentum, enery, and species and
then obtains the pressure from the equaition of state.
Time → Steady
Velocity-formulation → Absolute
2D Space → Planar
Also, setting up the gravity force in y-direction = -9.8 m/s2
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Next, set up the CFD simulation using the Models group in the Setting Up
Physics in the tab or clicking on the Tree
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Setting Up Model

1. Enable heat transfer by activating energy mode
Clicking on Setting Up Physics → Select Energy → Energy Equation →
OK

83



2. Select Viscous Model → Laminar

Clicking on Setting Up Physics → Select Viscous.. → Laminar → OK
Select Laminar because the system of blood flow is laminar flow with the
average mass flow is 0.0235 kg/s
3. Set up material

This step is for set up material for your CFD simulation by clicking on the
Flask symbol above or clicking or the Materials on the left tree and click
→ Create/Edit...
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Blood Properties
Property Value
Density 1060 [kg/m3]
Cp (Specific Heat) 3513 [J/kg −K]
Thermal Conductivity 0.44 [W/m−K]
Viscosity 0.003 [kg/m− s]

Table 5: Blood Properties

Figure 60: Set up material; blood and drug

a. Create Fluid: Blood

Create/Edit Materials in Fluid dialog box, change the Name to blood

Change Properties
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Then, click Change/Create.
A Question in dialog box will pop up → click No. So, the new material is
created in Fluid Material tab.

b. Create Fluid: Drug
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Drug Properties
Property Value
Density 1449.265 [kg/m3]
Cp (Specific Heat) 4000 [J/kg −K]
Thermal Conductivity 0.5 [W/m−K]
Viscosity 0.00001 [kg/m− s]

Table 6: Drug Properties

From the previous study, they use vancomycin as an antibiotic drug. So, I
will add the properties of vancomycin in drug fluid
Create the same step as in blood
c. Create Solid: Steel Normally, steel is the major component of a artificial
hips because its resistance.
Create solid is the same in Fluid, data of steel is already stored in Fluent
database.
Click on Fluent Database → select Steel → click copy to create a new
solid material. Then, → click Change/Create. Steel material will be stored
in set up material.
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On the models,
Radiation → Off
Heat Exchager → Off
Discrete Phase → Off
Acoustics → Off
Electric Potential → Off
4. Enable Chemical species transport and reaction

Clicking on Setting Up Physics → Models → Species

Specied model dialog box will show up, → Species Transport in the
model list
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Select mixture-template→ Edit→ click Edit... on Mixture Species again

Then, Click adding Blood and Drug in selected species box. And, remove
irrelevant species out. → Click OK
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5. Setting Cell zone condition

6. Setting Boundary condition

7. Initialize model

8. Solving model
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